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Using the BBS with
TeleFinder/User

TeleFinder/User is an application that connects your
Macintosh to a TeleFinder bulletin board system
(BBS).  TeleFinder/User requires a Macintosh Plus
or higher, and Apple’s System 7.0 or higher.
Through your TeleFinder/User-BBS interface, you’ll
find business services, customer support, as well as
“friendly chat.”  A BBS can also serve as a confer-
ence forum, provide electronic mail service, and
store files to be transferred.  The individual or
company operating the BBS ( the Sysop ) determines
which services to offer its callers.  The Sysop also
decides whether the BBS  will be open to public use,
or kept for private use.

TeleFinder provides an easy to use interface to work
with files, mail and messages by simply clicking and
dragging icons.  With System 7.5 TeleFinder uses
your Finder  desktop to provide “drag-and-drop”
file transfers.  With earlier system software
TeleFinder will emulate the Finder desktop to
provide the drag-and-drop capability.  TeleFinder
also includes a text editor, address book, and a mail
outbox for automating the pickup and delivery of
mail.
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The purpose of this section is to help you to get up
and running as quickly as possible.  The steps
outline the procedures for installing and configuring
TeleFinder/User.

Install and Open TeleFinder/User.

• With Finder, open the “TeleFinder™/User.sea”
file.  Then click on the "Continue" button in the
opening window.

• Use the “Save” dialog to choose a location to
install TeleFinder/User.  This creates the
“TeleFinder™/User " folder on your hard disk.

• Open the TeleFinder User application from inside
the TeleFinder/User folder.

Notice that TeleFinder/User automatically opens
the Default Settings file and loads the saved configu-
ration.  TeleFinder saves any configuration changes
you make in whichever settings file is currently
open.  Use the “Open…” command from the File
menu to choose a different settings file.

Software
Installation

Setting up
TeleFinder/User
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Configure the TeleFinder/User with your logon
name, password, BBS phone number, and informa-
tion about your modem.

Enter your logon name and password.

Choose a Connection Method

• If you are supporting dial-in access through your
modem then you will configure using the “Modem”
Connection Method.  For other connection methods
please refer to the “Customizing your BBS” section
of this manual.

•  Click in the “Setup” button in the Connection
window.  TeleFinder will open the “Modem Setup”
dialog.

Choose a Serial Port

• Select the serial port your modem is connected to
from the serial ports list of the “Modem Setup”
dialog.

You only need to perform the
following steps once.

Setting up the
Connection

Step 1

Step 2

Step 3
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 Select a Modem Setup

The modem setup configures TeleFinder with
settings to make your modem work properly.

• Scroll through the Modem Settings list, and click
on the name that most closely matches the name of
your modem to select it.

Notice that for some modems, there is a standard
version and an “HH” version.  “HH” stands for
“Handshake Hardware” cable.  Using a hardware
handshake cable permits faster transfers with 9600
bps and faster modems.

You should try the “HH” settings first, and if you
are unsuccessful in getting connections switch to the
non “HH” settings.  The cables that are shipped with
high speed modems are generally hardware hand-
shake cables.  Unfortunately, there is no way of
knowing, simply by looking at the cable, which type
you have.  Both the standard and “HH” cables have
the same physical appearance.

Enter the Telephone Number

• Enter the telephone number of the BBS you want
to connect to in the “Telephone Number” text field.

Note:   If you need to dial “9” to get an outside line,
enter it as “9,,” ( nine followed by two commas.
When using calling cards, enter your calling card
number in along with the telephone number.  You
may need to separate the telephone numbers from
the calling card number with two or more commas.
Each comma tells the modem to pause between the
numbers.

• Click in the "OK" button to save the settings.  Click
in the Connect button to place the call.

Step 4

Hardware
Handshaking

Step 5

Step 6
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See the “Setting up TeleFinder”  section if you need
instructions for setting the telephone number or
choosing a modem configuration.

TeleFinder dials the number using your modem and
then waits for the BBS Server to answer your call.
TeleFinder automatically will make repeated
attempts to connect to a busy line.  Click in the
Cancel button to stop.

You normally see the following messages in the Call
Progress portion of the Connection window while
TeleFinder is connecting.

Opening the Connection…
Connection Established…

After the modems connect, TeleFinder logs you on
to the bulletin board.  This is when the bulletin
board checks your name and password.  The BBS
starts this process.  You should see these messages
displayed in the dialer as log on takes place.

Waiting for the host…
Sending name and password…
Waiting for authorization…
Successful connection!

Connecting
to a

TeleFinder BBS

NOTE:  The logon procedure
may “hang” at the “Waiting for
the host” stage if you  choose

the wrong settings.  This
happens if you select a

hardware handshake setup
and do not have the proper

cable.  Choose the standard
setup if this occurs.
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If the log on fails, it is usually because the modems
did not make a good connection.  Poor connections
often result from using the wrong settings.  Correct
TeleFinder’s modem configuration if necessary.
Refer to the Trouble Shooting section of this manual
if you have problems connecting, or if your modem
is not shown in the Modem Setups list.

If your password is incorrect the BBS sends a
“TeleFinder Message” saying that your name or
password did not match.  If necessary, verify the
password and try again.

If you are not yet a registered user of your BBS or if
your logon name is misspelled, your BBS will send
you a message explaining what to do next.   If you
are already a user of the BBS, correct the name and
password in the Connection window  and try again.
If you are a new user of the BBS, fill in the registra-
tion form to request an account.

Registering
with a

BBS

Enter information to register
for a BBS logon account in
this dialog.
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After a successful connection, TeleFinder displays
the BBS Desktop window with the icons you have
access to.  Double-click on them to open them.

This screen is an example of what users see after
connecting to Spider Island Software's support BBS.
Bold icon names indicate new or recently changed
files.

TeleFinder displays file area  icons to provide you
access to demo, shareware, and public domain
software.  The Mailbox icon contains your mail.  The
Conferences icon contains message topics with
news, information and public discussions.  The
Upload Here! icon is used to send files to the BBS.
The BBS system operator chooses the icons and
names of BBS areas.

If an auto message was assigned to your access
group it will be automatically displayed.  You can
save the document as a text file or print it.  The
Session Time window shows BBS connection and
time information.

Icons received
from the

Bulletin Board
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When mail is waiting the mailbox icon shows a letter
sticking out of it.  No letter means there are no files
in your mailbox.  Mail remains in your mailbox until
you drag it to the Trash icon to remove it.

Your mailbox can contain both messages and
attached files.  You can read the messages by
opening their icons.

When a file is in your mailbox drag its icon to your
disk.  This begins the transfer of the file to your
Macintosh.  After the file transfer is complete, you
can open the file with the application used to create
it.  Other files may appear as attachments to a
message.  These files you can receive from the
message form window.

You can use TeleFinder’s electronic mail to exchange
messages and files between users of the bulletin
board system, and through gateways to other mail
systems.  TeleFinder provides you with a mail form
to compose and send messages.

TeleFinder/User also includes a Mail Outbox that
you can use to prepare mail off-line.  You can send
messages from the Mail Outbox at a chosen time,
during a connection, or immediately.

Using E-Mail

Sending Mail
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You can use the mail form to compose messages up
to 32K in size.  You can also attach files of any size to
the message.  The mail form uses standard Macin-
tosh editing commands.  You can import text into a
mail form from existing documents.  You can also
use TeleFinder’s text editor to compose a message
using parts of other text documents.  For more
information on working with text, please see the
“text editing and printing” section.

Within the BBS TeleFinder uses your logon name as
your e-mail address.  Through Mail Gateways
TeleFinder uses “Domain” addressing in the format
“user_name@domain.”  Addresses are not case
sensitive.  You can address a message using any one
of the following three methods:

Use the address TeleFinder provides by replying to
a message.

• Open mail another user sent to you.

• Click in the messages’ “Reply” button, or select
the “Reply to Mail” command from the mail menu.
TeleFinder will open a properly addressed mail
form.

Composing Messages

The mail form uses standard
Macintosh text editing
commands.  You can create
messages using styled text by
selecting commands from the
Fonts and Styles menus.

Addressing
Messages

Method 1



page  10

Select an Address from the Address Book

• Select the “New Mail Form” command from the
mail menu.  TeleFinder will open a mail form that
contains your logon name in the “From” text box.

• Click in the “To” button at the top of the window.
TeleFinder will open a dialog containing a list of all
the names in your address book.

• Select a name from the list.

• Click in the “OK” button to address the message.

Type a name into the “To” text box.

• Type or  paste the user’s name in the “To” text
box.

After addressing the e-mail, compose your message.
Then click in the Mail button to send the message.

Use Locate a User to learn the correct names of other
users of the BBS.

• Select the “Locate a User” command from the Mail
menu.  This opens the Locate dialog.

• The enter a part of the user’s name in the dialog’s
text box.  Leave it blank for a list of all the BBS users.

•  Click in the OK button to begin the search.
TeleFinder will display a User List containing all of
the matching names.

Method 2

Method 3

Using Locate
a User
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• Separate each name and/or address by using a
comma.

Note that you can freely mix the addresses of users
reached via gateways and local BBS user names.

File attachments are a convenient way to send files
to other people.  You can attach multiple files to
your messages.  When you Mail the message
TeleFinder sends the files to the BBS where they will
be processed and distributed.

Files that will be routed through an Internet or
Server to Server gateway will be converted to an
Internet format before they are transmitted.  As a
user this process is transparent and automatic, the
TeleFinder Server does all the necessary processing
and encoding.

The reverse is true when receiving files from a
person through a gateway.  In this case the
TeleFinder Server will convert the attached files
from the Internet format back into a usable
Macintosh or DOS file.

Addressing to
Multiple Users

File
Attachments
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•  Click in the “Attach” button on the Mail form.
TeleFinder will open the “Open” dialog.

•  Use the “Open” dialog to locate and select the file
you wish to attach to the message.

•  Click in the “Open” button.
TeleFinder will add the file to the attachments list.

To remove a file from the attachments list
•  Select it’s name in the list by clicking on it.
•  Hit the “delete” key or select the “Clear” com-
mand from the Edit Menu.

When another person sends you mail that includes
attached files TeleFinder will display the file names
in the attachments list.

Select the file’s name from the list, then click in the
“Receive” button to begin transferring the file to
your hard disk.

TeleFinder will put a copy of the file into the default
receive folder.  You can set this using the “Set
Receive Path” command from the File menu.

Attaching Files
to a Message

Removing
Attachments

Receiving a File
Atteachment
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TeleFinder supports ZMODEM , XMODEM-CRC,
and XMODEM-1K file transfers, in addition to a
“Background” protocol using TeleFinder’s native
communications facilities.  Select the file transfer
protocol you wish to use from TeleFinder’s Special
Menu.

Each of TeleFinder’s file transfer protocols provide
error correction using advanced error detection
techniques to insure accurate data transfer.

The Background transfer protocol lets you continue
to use the BBS while transfers are in progress.  You
can also send and receive files at the same time.
This is the preferred protocol because of it’s combi-
nation of speed and convenience.

ZMODEM file transfers have the advantage of 32-bit
CRC’s and file recovery.  If a ZMODEM file transfer
fails to complete, TeleFinder saves the part of the file
already received.  You can then complete the
transfer either on another call, or during the same
call.  Just drag the file to the same location to con-
tinue the transfer where it left off.

TeleFinder/User supports the “streaming” and
“windowed” ZMODEM variations.  Use streaming
to get the fastest file transfers.  Use windowed when
there is a flow control problem.  Switching to
windowed ZMODEM can be helpful if you notice a
large number of retransmits.

The XMODEM file transfer protocol does not require
flow control and has less overhead than ZMODEM.
Use XMODEM when you have small files to trans-
fer, or when you have problems with flow control.
XMODEM does not support file recovery.

Choosing File
Transfer

Protocols
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BBS Find File quickly searches selected parts of the
BBS for a file.  Select the “BBS Find File” command
from the Special menu.  TeleFinder opens the
window below.

• Select the part of the BBS you want to search from
the “Search” pop-up menu.  Every BBS icon that you
have access to appears in this menu.

• Choose the “Name Contains” if you know part of
the name of the file that you are looking for. Enter
the part you know in the field to the right of the
menu. If you enter partial strings ( ie: Tele Demo )
the file’s name matches when it contains both strings
( ie: TeleFinder Demo would match, TeleFinder.cpt
would not )

• Choose the type of item you are looking for.

Using BBS
Find File
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• Enter date criteria when you are looking for new
files, old files, or files last modified on a separate
date. Choose “any date” to broaden the search to
include more possible matches.

• Click in the “Find” button to begin the search.

TeleFinder builds a list of the files and folders it
finds.

Once the search is complete, you can open, and get
information about, the files TeleFinder finds.

• Select a file or folder from the list.

•  Click in the Open button to display e-mail, text,
graphics and message topics.  If TeleFinder cannot
display the type of file selected in the list, the Open
button will display the Info window.

•  Click in the Receive button to begin the transfer of
the selected file to your Macintosh.

Select “Disconnect” from the Special menu.  This
command logs you off from the BBS, then tells the
modem to disconnect from the line.

TeleFinder’s address book stores person’s e-mail
address and, optionally, their names.  Follow the
instructions below to add a user’s name to the
Address Book

• Select the “Open Address Book” command from
the mail menu.  TeleFinder displays the names of the
users in your address book in the Addresses win-
dow.

Disconnecting
from a BBS

Working with
Found Files

Maintaining the
Address Book
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• Click in the “Add” button to add a name to the
list.  TeleFinder opens the “User Address” dialog.

• Enter the e-mail address and name into the
dialog’s text boxes.  You can enter up to 255 charac-
ters each the e-mail and name text box.  As shown
above, you can enter any informative text into the
name field.

• Click in the “OK” button to add the name to the
address book.

You need to select a name from the list in the
“Addresses” window before you can use the other
buttons.  They perform the following functions:

- Mail Form: Click on this button to open an
addressed Mail Form to compose e-mail.

- Mailbox : Click on this button when you are on-
line to get the drop-box icon of a local BBS user.

- Add : Click on this button to add an entry to the
address book.
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- Change : Use this to change the e-mail address
or name.

- Remove : Use this to remove a name from your
address book.

You can use the Mail Outbox to automatically pick
up and deliver mail.  Compose and address your
messages, then add them to the Mail Outbox for
later delivery.  You can queue up to 250 messages in
the Mail Outbox.

You can use the Mail Outbox to send messages at a
later time, or upon demand.  In either case,
TeleFinder/User needs to be open at the time you
want to send the mail.

The following steps explain how to add a message to
the  Mail Outbox.

• Compose and address a message using
TeleFinder’s Mail Form.

• Use the “Save as…” command from the file menu
to save the message on your hard disk.

Save messages you want to send later as “E-Mail” files.  Be sure
that the “E-Mail” button is selected in the “save” dialog.

• Choose the “Open Mail Outbox” command from
the Mail menu.  TeleFinder will open the “Mail
Outbox” window.

Using the Mail
Outbox

Adding Files to
the Mail Outbox
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• Click in the “Add” button to select the message
you previously saved.  TeleFinder will open the
“Open” dialog box.

• Use the “Open” dialog to navigate to the message.
Select the message you wish to send from the list in
the dialog box.

• Click in the “Open” button.  TeleFinder then adds
the file and user name to the list in the Outbox
window.

The TeleFinder mail form includes a “Mail Later”
button. After you’ve finished composing a message,
use this button to add the message directly to the
outbox.

If you want TeleFinder to
download any mail waiting in

your mailbox, turn on the
“Pick up my mail too!”

checkbox..

Adding E-Mail
directly to the

Mail Outbox
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After selecting the messages you want to send, you
can choose to send them now, during the next
connection, or at a specific time.

• Click in the “Send Now” button to send the files
now.  TeleFinder will connect to the BBS, transfer
the files, then hang up.  TeleFinder uses the settings
in the Auto Dialer window to make the connection.

• Click in the “Next Connect” button.  After you
connect to the BBS, and select the “Quit” or “Hang
Up” command, TeleFinder will check the Outbox.  If
there are files ready to send,  TeleFinder will ask
whether or not to send them.

• Click the “Send Files At” button to set a time for
sending.  TeleFinder will open the “Date/Time Set”
dialog.

• In the dialog, enter the time and date you want
TeleFinder to send the files.

• Click in the “OK” button to save the time setting.
When TeleFinder is open, it will check to see if it is
time to send files.  When that time passes,
TeleFinder uses the settings in the Auto Dialer
window to connect to the BBS.  Then it transfers the
files and hangs up.

The message viewer window contains buttons to
select a message, reply to a message, and remove a
message from a topic.  You can also print messages,
and save messages as text files, using commands in
the File menu.

NOTE:  Only the Sysop , topic administrator, or the
person who originally posted a message can remove
a message from a topic.

Selecting a
Time to Send

Sending Now

Sending at Next
Connection

Sending at a
Specific Time

Using Message
Topics
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When you first open a topic, TeleFinder automati-
cally  displays a message in the viewer window.
TeleFinder selects this message based on the date
you last read messages.

You can select a specific message by its number or
post date.   You can also select messages from a list
of message subject headers.

Click in the “Right Arrow” button to view  new
messages by post date.  Click in the “Left Arrow”
button to view  previous messages in descending
order by date.   The current message number is
shown between the arrows.

Use “Select By Number” to select a message by its
message number.  This method  is useful when you
want to skip to the end, or start over at the begin-
ning, of a topic.

• Click in the “By Number”  button.  TeleFinder will
open the “Get Message” dialog.

• Enter the number of the message you want to see
in the dialog’s text box.

Selecting Messages

Selecting By
Number
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• Click in the “OK” button.  TeleFinder will display
the message associated with that number in the
viewer window.

If the message number that you enter is higher than
the number of messages in the topic,  TeleFinder will
display the topic’s last message.

Use “Select By Date” to select a message by its post
date.  This method is useful when you want to find a
message that was posted around a given date.

• Click in the “By Date”  button.  TeleFinder will
open the “Date/Time Set” dialog.

• Enter a date and time in the dialog.

• Click in the “OK” button.  TeleFinder will then
display the message that has a post date closest to
the date you specify.

TeleFinder will display the topic’s last message if the
date you provide is greater than the post date of any
message in the topic.  TeleFinder will display the
topic’s first message if the date you provide is earlier
than the post date of any message in the topic.

Use “Select From List” to view a list of message
headers.  A message header includes the To, From,
Subject, and Post Date information from a message.
This method is useful when you want to scan a topic
for messages about specific subjects.

Selecting Messages
from a List

Selecting By Date
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• Click in the “From List” button.   TeleFinder will
open the “Get Message” dialog.

• In the dialog’s text box, enter the number of the
first message you want to appear in the list.

• Then click in the “OK” button.  TeleFinder will
open the “Scan List” window and display up to 10
message headers in it.

• Select a message header from the list.  Then click
in the “Open” button.  TeleFinder will then bring the
message viewer window to the front, and display
that message.

Click in the “New List” button to clear the current
list and begin a new list.  TeleFinder will repeat the
steps to create a new list of message headers.

Replies to messages can be public  or private.
TeleFinder sends private replies as e-mail to the
user’s mailbox.   TeleFinder adds public replies as a
new message in the topic.  You compose both types
of replies using the reply window.  Follow the steps
below to reply to a message.

• Click in the “Reply” button to open a reply
window.  TeleFinder addresses the reply using
information from the message viewer window.

Replying to
Messages
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• If necessary, change the “Subject” and “To” fields.

To  –- Use this to address your reply to a differ-
ent person.
Subject –- Enter new text to describe the subject
of your message here.

• Click in the “Post” button add the message to the
topic.

• Click in the “Mail” button to send the message to
the addressee’s mailbox.

Users with the appropriate access privileges can
create new topics in Conference folders.  A user
needs to have either the global “Can Make Changes”
Sysop  privilege, or the “Can create topics” path
privilege to be able to create new topics.   To create a
new  message topic, follow the steps below.

• Bring a conference window to the front of the
screen.

TeleFinder’s Topics also
support file attachments.  Just

click in the “Attach” button to
add files to the attachments

list.

Creating a New
Topic
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• Then select the “New Topic in  ‘window’” item
(“Sysop’s Corner” in this example) from the Mail
menu.  This will open a message reply window  as
shown below.

• Address the message to a specific user, or generi-
cally to “ALL.”

• Enter a subject name in the subject text box.  The
name  you enter becomes the name of the topic icon
in the conference you are creating the topic in.

• After composing your message click in the “Post”
button.   TeleFinder then sends the message and
creates the topic icon in the conference window.

Use TeleFinder’s Subscribe to Topic feature to keep a
copy of the messages in a topic on your own hard
disk. You can then read and reply to messages even
when you’re off-line.

Follow these steps to start a subscription:

• Connect to a TeleFinder BBS.
• Open the conference folder containing the topic
you want to subscribe to.
• Select the topic icon.
• Then select “Subscribe to Topic” from the “Mail”
menu.

Subscribing
to Topics
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TeleFinder will then download the messages and
make an entry for the topic in TeleFinder’s Topic
Inbox. You’ll see each message appear on your
screen as TeleFinder saves them.

From the “Mail” menu select the “Open Topic
Inbox” command. TeleFinder will display a list of
topics you subscribe to.

The list shows the name of the topic, the source BBS,
the date TeleFinder last updated the topic, and the
update frequency option.

TeleFinder sets new subscriptions with a daily
update frequency. This means that TeleFinder will
request new messages from the BBS and send
messages you post just once per day. TeleFinder
updates topics when you connect to the source BBS
just after the BBS icons appear on your screen.

Use the Options button to change the update
frequency to each call or put the subscription on
hold.

When the subscription is on hold TeleFinder will
only update the topic when you use the Update
button. You can use the Update button to update the
topic manually. You need to be on-line to update a
topic.

Use the trash button to remove a topic from the
subscription list. To reclaim disk space you need to

Opening the
Topic Inbox

Topic Update
Frequency

Removing a Topic
Subscription
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delete the topic icon and it’s message folder. The
topic icon and message folder are in the Incoming
Topics Folder. The Incoming Topics Folder is in the
same folder as TeleFinder.

You’ll need to restore a subscription if any one of
the three events occur:

• If you rename your settings file. TeleFinder uses
this name to indicate which service you’ve con-
nected to.

• If the BBS sysop moves or renames the original
topic. If the sysop renames the topic, you should
also rename the topic icon in the Incoming Topics
Folder.

• If the BBS sysop reformats the BBS hard disk.

You can restore subscriptions by re-subscribing to
them. Just repeat the original subscription steps.
TeleFinder will not download messages that are
already in your Incoming Topics Folder, it will just
download new messages.

The icons in the upper left portion of windows
describe the access privileges you have within a
given folder.  The BBS system operator may assign
you any combination of Write, Delete, See Files and
See Folders access.

The most common access within a “Files” folder is
“No Write, No Delete, See Files and See Folders.”
With these privileges you can download the files

Folder Access
Privileges

Restoring a Topic
Subscription
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contained within that folder but cannot delete files,
or add new files to the folder.

Conference areas access is usually : “Write, No
Delete, See Files and See Folders.”   With these
privileges you can create new topics within the
conference and post your own messages to existing
topics.

Use the Chat window to send notes between the
system operator and user.  Select the “Chat with
Sysop” command from the Chat menu.  TeleFinder
will open the Chat window.

You can use Chat anytime you are on-line.   Chat is
possible  during  Background file transfers but not
during ZMODEM file transfers.

• Click in the  “Send” button to send the message in
the text box.

• Click in the “Clear” button to clear the chat
window of messages.

• Click in the “Scroll Lock” button to turn on and off
automatic scrolling of messages.  Automatic scroll-
ing makes new messages visible on the screen.

Multi-User chat provides four additional functions:
- Chat rooms where many users can chat together.
- Instant messages where you can send messages

directly to another user.
- A list of the users currently on-line.
- A list of the users currently in a chat room.

These capabilities are present on multi-node BBS's
that run the Chat Server, or TeleFinder Server 4.0
and higher.  When multi-user chat is not available
TeleFinder will disable the Chat commands.

Using Multi-
User Chat

Chatting with
the Sysop
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The Chat commands, and log file commands are
grouped together in the Chat  menu.  The "List of
Users On-line" and the "List of Users in this Room"
are active only when you connect to a TeleFinder
BBS that supports multi-user chat.

Chat rooms appear in your BBS Desktop window
just like other areas of the BBS do.  The "Chat Room"
icon above shows the default icon for chat rooms.
Sysops can assign any icon to a chat room.

This is the chat room window.  Messages you enter
appear along with the messages from users in the
room.  You can enter up to 1K of text to send in this
window.  The "In" and "Out" status lines show you
when users enter and leave the room.

Select the “List of Users On-line” command when
you are on-line to produce a list like this. This list
does not update itself, so its “Update List” button to
get a current listing.

List of User’s
On-Line
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- Use the “Mail Form” button to pop open an
addressed mail form to the selected user.

- Use the “Mailbox” button to get the “Drop-box” for
the selected user.

- Click in the “Instant Message” button to open the
window to enter and send an instant message.

Instant Messages are a quick and easy way to send a
short note to another user while they are on-line.
They are also useful to send a private note to an-
other user while you are chatting in a chat room.
You can enter up to 1K of text to send in this win-
dow.

Use the “Capture File” commands to capture text
from the terminal window, Chat Rooms, Chat with
Sysop, and Instant Messages to a text file.  Once you
have the text file open you can toggle the “Capture
On” setting to selectively capture text during a
session.

TeleFinder has a built-in text editor to create, print,
and edit documents using styled text. You can open
a text document from a local disk at any time.  You
can open text documents from the BBS while you are
on-line.  You can not edit BBS documents until you
save them on your own disk.

To open an untitled document, select the “New
Text” command from the File menu.  This opens an
untitled text editor document.  The text editor
supports the standard menu commands in the Edit
and File menus.   The text editor also supports the

Text Editing
and Printing

Creating  New
Documents
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“Import Text” and “Special Import” commands in
the file menu.

You can open text documents using the “Open”
dialog

• Select the “Open…” command from the File
menu.   TeleFinder displays the “Open” dialog.

• Select a file from the “Open” dialog.

• Click in the dialog’s “Open” button.  TeleFinder
then opens the document in a text editor window.

The text editor supports movement of the insertion
point using keyboard commands.  The e-mail and
topic reply windows also support these commands.

• Use the “Up Arrow” key to move the insertion
point up one line.

• Use the “Down Arrow” key to move the insertion
point down one line.

• Use the “Left Arrow” key to move the insertion
point left one character.

• Use the “Right Arrow” key to move the insertion
point right one character.

Holding down the Option key while using the arrow
keys magnifies the movement of the insertion point.

• Use the “Home” key, or type “Option+Up Ar-
row”, to move the insertion point to the top of the
document.

• Use the “End” key, or type “Option+Down
Arrow”, to move the insertion point to the end of the
document.

Opening Existing
Documents

Using Special Keys
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• Type “Option+Left Arrow” to move the insertion
point to the beginning of the line.

• Type “Option+Right Arrow” to move the insertion
point to the end of the line.

The “Page Up” and “Page Down” keys scroll the
document without changing the insertion point.  The
“Enter” key scrolls the document to make the
insertion point visible.

The “Import Text” and “Special Import” commands
merge text into your e-mail, topic reply, or text
documents.  Merging text takes the text of an
existing file and adds it to another document.   The
new text is added at the insertion point, replacing
any selected text.

• Use the “Import Text” command to merge a file
without filtering.

• Use the “Special Import” command to filter the
text in a file  before merging it.  Filtering strips
unused control characters and hard returns as it
merges text.  This process promotes better word-
wrapping and cleans up files originating from DOS.

You can apply Font, Size, Style, and Color attributes
to the text in e-mail, public messages, and text
documents.  TeleFinder is “WorldScript” compatible
so using Japanese  and other multi-byte fonts like
“Osaka” is as simple as using ASCII fonts like
“Helvetica.”

TeleFinder automatically inserts the contents of the
file named “MessageClosing.txt” each time you
open a "New Mail Form" or reply to an existing
message.  Customize this file to include your name
and a "stock" message closing and choice of default
font/style for your messages.  Delete the file if you
don't want automatic closing insertion.

Importing Text

Composing Messages
with Styled Text

Automatic Message
Closing
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You can make this file using TeleFinder’s text editor.
It must be in the same folder as TeleFinder/User.

You can print text documents at any time except
during a file transfer.

The BBS may disconnect you if a document takes
more than a few minutes to print.  It is better to print
while you are off-line, or to print only small docu-
ments while you are on-line.

To print a document, use the “Chooser” Desk
Accessory to select the printer you want to use.
Then  select the “Page Setup” command from the
File menu.  This opens a common dialog to select
options supported by your printer.

Select the “Print” command from the File menu to
prepare and send the document to the printer.
TeleFinder prints your document using the same
Font that is used to display it on the screen.

Select a file icon, then select “Get Info” from the File
menu.  TeleFinder displays the file’s name, size, and
the date it was created and last modified in the
“Info” window.  A description of the file and
preview picture may also be present.

Click on the “Receive” button to transfer the file to
your “Receive folder.”  The file transfer process
begins immediately.

Printing

Using
File

Information
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NOTE: You can also drag the file’s icon to a specific
folder to transfer it to that location, or the File Basket
window to save it for later transfer.

TeleFinder’s “By Thumbnail” view is the best way to
browse files that contain textual descriptions and
preview pictures.

.

To use the thumbnail view select the “By Thumb-
nail” Option from the Windows menu.  TeleFinder
will then display the file folder as shown above.

Continue to use the file’s icon for drag and drop
even while in the “By Thumbnail” view.  It is not
necessary to switch back to “By Icon” view to start
file transfers.

To receive a file you simply drag the file to wish to
receive to your hard drive icon.   To receive a file in
an area other than the root level of your hard drive,
open the hard drive icon first and maneuver to the
folder you wish to place the file, and drag the file
directly to that folder.

You can send or receive a group of documents at the
same time.  Select the icons identifying the group of
files.  Then drag them to their destination.  You can

Using
“By Thumbnail”

Folder View

Receiving Files

Batch File
Transfers
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select them all at once by drawing a selection
rectangle around them, or individually by holding
the shift key down while you click on individual
icons.

Use the File Basket when you want to make batch
transfers from separate locations.  First put the
different files into the File Basket, then make the
batch transfer from the File Basket to your hard disk.

Drag a file’s icon to the Upload icon in the BBS
Desktop window.  That is all that is necessary to
begin a file transfer using TeleFinder.  After the
transfer is complete, there will be an exact copy of
the file on the BBS’s hard disk.  The BBS Sysop
decides which folder uploads go into using  access
group settings.

You can also transfer files directly to a “Files” area
when you have “Write” privileges in that area.

TeleFinder’s File Basket is the best way to keep track
of files that you might want to download later.

To use the File Basket  just drag a file’s icon to the
File Basket window.  TeleFinder will create it’s own
alias of the file in the File Basket window.

Sending Files
to the BBS

Using the
File Basket
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File Basket aliases support all of TeleFinder’s file
operations.  You can use them to transfer, view,
open and get file information.

Viewing the File Basket by Thumbnail lets you
easily compare images and file descriptions.

You can just drag files from the File Basket to your
hard disk as you would from any folder.

TeleFinder will also prompt you to download files in
your File Basket before you disconnect.  If you
choose Yes, TeleFinder will download all the files in
the File Basket, then disconnect.

Files can be removed from the File Basket by drag-
ging files to the trash can. Files that are dragged
from the File Basket to the trash can are not deleted
from the BBS, only removed from your File Basket.

TeleFinder supports graphics viewing both on, and
off-line.  The types of graphics files supported are:
GIF ( Graphics Interchange Format ), PICT
( Macintosh picture format ), and JPEG compressed
pictures ( requires QuickTime 1.0 or better ).

Open the graphics file icon to view the file while on-
line.  Use the “Open…”  command from the File
menu to open a file from your Hard Disk.

Downloading from
the File Basket

Viewing
Graphics
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The GIF format has several advantages for on-line
viewing.

- GIF uses lossless compression to keep file size
small without sacrificing image quality.

- GIFs can be “interlaced” which lets you see the
full picture sooner.

- GIF supports up to 8 bit color and custom
palettes.

You can open the “Session Time” window by
selecting the “Session Time” command from the
Special menu.  This window displays a variety of
useful information while your connected to the BBS.

The Session Time window displays the following
information.

Session Time
Window
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BBS Node Name - “Spider Island Modem 1,” this is
the name assigned by the BBS operator to the node
of the BBS you are connected to.  On multi-line
BBSes each Node will usually have a different name.

Connection Info - “•Modem, speed 14400 bps,
connected.”  This show that you’re modem is
connected to the BBS at 14.4 kbps.

Time Connected - This displays the running total of
hours, minutes and seconds that you been connected
for in the current session.

Time Remaining - This shows how much longer
you may be connected for in the current session.
Since BBSes have a limited number of modems most
system operator impose “per logon” time limits for
each user.

Last Logon - This is the time and date of your last
connection to the BBS.

Host Time - This is the local time and date at the
moment of your connection to the BBS.

K’s Downloaded - This is the cumulative number of
kilobytes that you’ve downloaded from the BBS.
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